SolidWorks® 2013
Part I - Basic Tools
Parts, Assemblies and Drawings

Paul Tran CSWE, CSWI

Supplemental Files
Tutorial files on enclosed CD
Visit the following websites to learn more about this book:

SDC Publications  amazon.com  BARNES & NOBLE  Google books
- Upon successful completion of this lesson, you will be able to:

* Sketch on planes and/or planar surfaces.
* Use the sketch tools to construct geometry.
* Add the geometric relations or constraints.
* Add/modify dimensions.
* Explore the different extrude options.

- The following 5 basic steps will be demonstrated throughout this exercise:

* Select the sketch plane.
* Activate Sketch pencil $\text{ pencile }$.
* Sketch the profile using the sketch tools $\text{ pencil, circle, line }$.
* Define the profile with dimensions $\text{ dimension }$ or relations $\text{ related }$.
* Extrude the profile $\text{ extrude }$.

- Be sure to review the self-test questionnaires at the end of the lesson, prior to moving to the next chapter.
Basic Solid Modeling

Extrude Options

Tools Needed:

- Insert Sketch
- Line
- Circle
- Add Geometric Relations
- Dimension
- Sketch Fillet
- Boss / Base
- Extrude

Dimensioning Standards: ANSI
Units: INCHES – 3 Decimals

View Orientation Hot Keys:
Ctrl + 1 = Front View
Ctrl + 2 = Back View
Ctrl + 3 = Left View
Ctrl + 4 = Right View
Ctrl + 5 = Top View
Ctrl + 6 = Bottom View
Ctrl + 7 = Isometric View
Ctrl + 8 = Normal To Selection
1. **Starting a new Part:**

   - From the **File** menu, select **New / Part**, or click the **New** icon.

   - Select the **Part** template from either the Templates or Tutorial folders.

   - Click **OK**; a new part template is opened.
2. Changing the background color:

- From the View (Heads-up) toolbar, click the Apply Scene button (arrow) and select the Plain White option (arrow).

- By changing the background color to Plain White we can better see the colors of the sketch entities and sketch dimensions.

- To show the Origin, click the View dropdown menu and select Origins.

- The Blue Origin is the Zero position of the part and the Red Origin is the Zero position of a sketch.
3. Starting a new Sketch:

- Select the Front plane from the Feature-Manager tree and click the Pencil icon to start a new sketch.

- A sketch is normally created first, relations and dimensions are added after, and then it gets extruded into a 3D feature.

- From the Command-Manager toolbar, select the **Line** command.

**OPTION:**

Right-Drag to display the Mouse Gesture guide and select the Line command from it. (See the Introduction section, page XVIII for details on customizing the Mouse Gesture).

- Position the mouse cursor at the Red Origin point, a yellow feedback symbol appears to indicate a relation (Coincident) is going to be added automatically to the 1st endpoint of the line. This endpoint will be locked at the zero position.
4. Using the Click + Hold + Drag technique:

- Click on the Origin point and **hold** the mouse button to start the line at point 1, **drag upwards** to point 2, then release the mouse button.

- Continue adding other lines using the **Click-Hold-Drag** technique.

- The relations like Horizontal and Vertical are added automatically to each sketch line. Other relations like Collinear and Equal are added manually.

- The size and shape of the profile will be corrected in the next few steps.

---

**The Base Sketch**

The Base Sketch is the parent sketch of a part and is also the very first sketch in a part document. It should primarily describe the basic shape of the part, before other features can be added.

---

**System Feedback**

While sketching the lines, watch for the System Feedback Symbols such as for Horizontal, and for Vertical Auto Relations.
5. Adding Geometric Relations*

- Click Add Relation \[\text{Add Relation}\] under Display/Delete Relations - OR - select \textbf{Tools / Relations / Add}.

- Select the 4 lines shown below.

- Click \texttt{EQUAL} from the Add Geometric Relation dialog box. This relation makes the length of the two selected lines equal.

* Geometric relations are one of the most powerful features in SolidWorks. They’re used in the sketch level to control the behaviors of the sketch entities when they are moved or rotated and to keep the associations between one another.

When applying geometric relations between entities, one of them should be a 2D entity and the other can either be a 2D sketch entity or a model edge, a plane, an axis, or a curve, etc.

Equal Relations

Adding the \texttt{EQUAL} relations to these lines eliminates the need to dimension each line.

Geometric relations can be created manually or automatically. The next few steps in this chapter will demonstrate how geometric relations are added manually.

Select the top 4 lines and click Equal relation

The top 4 lines are now Equal in size.
6. Adding a Collinear relation**: 

- Select the **Add Relation** command again.
- Select the 3 lines as shown below.
- Click **COLLINEAR** from the Add Geometric Relations dialog box.
- Click **OK**.

![Collinear Relations](image)

Adding a Collinear relation to these lines puts them on the same height level; only one dimension is needed to drive the height of all 3 lines.

**Collinear relations can be used to constrain the geometry as follow:

- Collinear between a line and another line(s) (2D and 2D).
- Collinear between a line(s) to an edge of a model (2D and 3D).
Geometric Relations Examples

- **Coincident**: An endpoint is coincident with a line.
- **Midpoint**: An endpoint is coincident with a midpoint of a line.
- **Tangent**: An arc is tangent with a line or another arc.
- **Concentric**: Two circles are sharing the same center.
- **Vertical**: Two or more points are aligned vertically.
- **Horizontal**: Two or more points are aligned horizontally.
- **Equal**: Two circles or two lines having the same size.
- **Tangent**: Two lines are on the same level (or co-planar).
- **Collinear**: Two lines are on the same level (or co-planar).
7. Adding the horizontal dimensions:

- Select \( \sqrt{ } \) from the Sketch toolbar - OR - select Insert / Dimension, and add the dimensions shown below (follow the 3 steps A, B and C).

**A. Click line 1**

**B. Click line 2**

**C. Place the dimension approximately here** and enter .500 in.

- Continue adding the horizontal dimensions as shown here.

**NOTE:**
*The color of the sketch lines changes from Blue to Black, to indicate that they have been constrained with a dimension.*
8. Adding the Vertical dimensions:

- With the Smart-Dimension tool still selected, click on line 1 and line 2; place the dimension approximately as shown, and change the value to \(0.500\) in.

- Continue adding other dimensions until the entire sketch turns into the Black color.

**The Status of a Sketch:**

The current status of a sketch is displayed in the lower right corner of the screen.

- **Fully Defined** = Black
- **Under Defined** = Blue
- **Over Defined** = Red
9. Hiding the Sketch Relation Symbols:

- The Sketch Relation Symbols indicates which geometric relation a sketch entity has, but they get quite busy as shown.

- To hide or show the Sketch Relation Symbols, go to the View menu and Click off the Sketch Relations option.

### Sketch Relation Symbols at a Glance

- **Horizontal relation**
- **Vertical relation**
- **Equal relation**
- **Coincident relation**
- **Tangent relation**
- **Collinear relation**
10. Extruding the Base:

- The **Extrude Boss/Base** command is used to define the characteristic of a 3D linear feature.

- Click from the Features toolbar - OR- select **Insert / Boss Base / Extrude**.

- Set the following:
  - Direction: **Blind**.
  - Depth: **6.00 in**.
  - Enabled **Reverse** direction.

- Click **OK**.
11. Sketching on a Planar Face:

- Select the face as indicated.

- Click \( \text{or select Insert/Sketch.} \)

- Click \( \) from the Sketch Tools toolbar
  Or select \( \text{Tools / Sketch Entity / Circle.} \)

(From the View toolbar above the CommandManager, click the Isometric icon
or press the shortcut keys \( \text{Ctrl}+7 \)).

Select the Sketch Face

- Position the mouse cursor on
  the selected face, click and
drag outward to draw a circle.

- While sketching the circle,
  the system displays the radius
  value next to the mouse cursor.

- Dimensions are added after the
  profile is created.

Planar Surfaces

- A planar surface of the
  model can also be used as
  a Sketch Plane.

- The Sketch will then be
  extruded normal to the
  selected surface.
- Select the Smart Dimension command and add a diameter dimension to the circle.

(Click on the circle and move the mouse cursor outward, at approximately 45 degrees, and place it).

- To add the location dimensions click the edge of the circle and the edge of the model, place the dimension, then correct the value.

- Continue adding the location dimensions as shown, to fully define the sketch.

12. Extruding a Boss:

- Switch to the Feature toolbar and click or select Insert / Boss-Base / Extrude.

Explore each extrude option to see the different results. Press Undo to go back to the original state after each one.
A Using the Blind option:

- When extruding with the Blind option, the following conditions are required:
  * Direction
  * Depth dimension

- Drag the direction arrow on the preview graphics to define the direction, then enter a dimension for the depth.

B Using the Through All option:

- When the Through All option is selected, the system automatically extrudes the sketch to the length of the part, normal to the sketch plane.

C Using the Up To Next option:

- With the Up To Next option selected, the system extrudes the sketch to the very next set of surface(s), and blends it to match.
**D Using the Up To Vertex option:**

- This option extrudes the sketch from its plane to a vertex, specified by the user, to define its depth.

**E Using the Up To Surface option:**

- This option extrudes the sketch from its plane to a single surface, to define its depth.

**F Using the Offset From Surface option:**

- This option extrudes the sketch from its plane to a selected face, then offsets at a specified distance.
Using the **Up To Body** option:

- This option extrudes the sketch from its sketch plane to a specified body.

  ![Up To Body](image)

- The Up To Body option can also be used in assemblies or multi-body parts.

Using the **Mid Plane** option:

- This option extrudes the sketch from its plane equally in both directions.

- Enter the Total Depth dimension when using the Mid-Plane option.

![Mid Plane](image)
- After you are done exploring all the extrude options, change the final condition to: **Through All**

- Click **OK**.

- The system extrudes the circle to the outer most surface as the result of the Through All end condition.

- The extra material between the first and the second extruded features are removed automatically.

- Unless the Merge Result checkbox is cleared, all interferences will be detected and removed.

**Extrude summary:**

* The Extrude Boss/Base command is used to add thickness to a sketch and to define the characteristic of a 3D feature.

* A sketch can be extruded in both directions at the same time, from its sketch plane.

* A sketch can also be extruded as a solid or a thin feature.
13. Adding the model fillets*:

- Fillet/Round creates a rounded internal or external face on the part. You can fillet all edges of a face, select sets of faces, edges, or edge loops.

- The **radius** value stays in effect until you change it. Therefore, you can select any number of edges or faces in the same operation.

- Click or select **Insert / Features / Fillet/Round**.

- Enter **.125 in.** for radius value.

- Select the edges as indicated to add the fillets. Since the fillets are the same size, it is quicker to create them together as one feature.

- Click **OK**.

- Zoom or rotate to view the complete fillets.
* In the attached CD, in the Built Parts folder you will also find copies of the parts, assemblies, and drawings that were created for cross references or reviewing purposes.

* **Fillets and Rounds:**
  
  Using the same Fillet command, SolidWorks "knows" whether to add material (Fillet) or remove material (Round) to the faces adjacent to the selected edge.

**14. Saving your work:**

- Select **File / Save As**.

- Enter **Extrude Options** for the name of the file.

- Click **Save**.
Questions for Review

1. To open a new sketch, first you must select a plane from the FeatureManager tree.
   a. True
   b. False

2. Geometric relations can be used only in the assembly environments.
   a. True
   b. False

3. The current status of a sketch is displayed in the lower right area of the screen as:
   Under defined, Fully defined, or Over defined.
   a. True
   b. False

4. Once a feature is extruded, its extrude direction cannot be changed.
   a. True
   b. False

5. A planar face can also be used as a sketch plane.
   a. True
   b. False

6. The Equal relation only works for Lines, not Circles or Arcs.
   a. True
   b. False

7. After a dimension is created, its value cannot be changed.
   a. True
   b. False

8. When the UP TO SURFACE option is selected, you have to choose a surface as an end-condition to extrude up to.
   a. True
   b. False

9. UP TO VERTEX is not a valid Extrude option.
   a. True
   b. False
**Exercise: Extrude Boss & Extrude Cut.**

1. Dimensions are in inches, 3 decimal places.
2. Use Mid-Plane end condition for the Base feature.
3. The part is symmetrical about the Front plane.
4. Use the instructions on the following pages if needed.
1. Starting with the base sketch:

- Select the Front plane and open a new sketch.
- Starting at the top left corner, using the line command, sketch the profile below.
- Add the dimensions shown.
- Add the Parallel relation to fully define the sketch.
- Extrude Boss/Base with **Mid Plane** at 3.000” deep.
2. Adding the through holes:

- Select the face as indicated and click the Normal-To button.

- This command rotates the part normal to the screen.

- The hot-key for this command is Ctrl + 8.

- Sketch a centerline that starts from the origin point.

- Sketch 2 circles on either side of the centerline.

- Add the diameter and location dimensions shown.

  Both circles are Symmetric about the Centerline

- Hold the Control key and select both circles and the centerline, then click the Symmetric relation on the properties tree.
3. Adding the upper cut:

- Select the upper face and click the Sketch pencil to open a new sketch.

- Sketch a centerline that starts at the Origin.

- Sketch a rectangle as shown.

- Add the dimensions and relations as indicated.

- Create an extruded cut using the Up-To-Vertex condition (up-to-surface also works).

- Select the Vertex indicated.

- Click OK.
4. Adding the lower cut:

- Select the **lower face** of the part and open a new sketch.
- Sketch a rectangle on this face.
- Add a Collinear and an Equal relations to the lines and the edges as noted.
- Extrude a cut using the Through All condition.

5. Adding a chamfer:

- Click **Chamfer** under the Fillet button.
- Enter **.060** for depth.
- Select the 4 circular edges of the 2 holes.
- Click **OK**.

6. Saving your work:

- Click **File / Save As**.
- Enter **Extrudes_Exe1** for the file name.
- Select a location to save the file.
- Click **Save**.